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Создадим логотип для фермерского хозяйства. Он будет состоять из нескольких объектов и текста. Основой для нашего логотипа будет служить инструмент Перетекание.
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Создаем логотип в CorelDRAW
Для начала познакомимся с интерактивными инструментами.
1. Создаем новый документ.
В левой части видим панель инструментов.
Нужные нам интерактивные инструменты находятся в зеленом квадрате. Чтобы просмотреть их все необходимо нажать треугольник в правом углу меню.
[image: ]
Существует 7 типов интерактивных инструментов: Тень, Контур, Перетекание, Искажение, Оболочка, вытянуть, Блок с тенью.
[image: ]
Каждый инструмент по-своему уникален и у каждого есть свои свойства. Для демонстрации создадим два объекта и зададим им цвета абрисов (без заливки).
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Выберем инструмент Перетекание, и удерживая левую кнопку мыши проведем от первого объекта ко второму.
[image: ]
В результате получаем замысловатую фигуру.
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2. Теперь приступим к созданию логотипа.
Для примера создадим логотип для какого-нибудь фермерского хозяйства. Он будет состоять из нескольких объектов и текста. Для начала создадим простой элемент и изменим его форму.
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Переведем его в кривые и изменим с помощью инструмента Создания форм.
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Далее необходимо продублировать полученный объект с уменьшением размера.
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Зальем объекты в оттенки красного.
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Далее инструментом Перетекание создадим перетекание от первого объекта ко второму и от второго к третьему, чтобы получилось следующее.
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Следующим шагом будет удаление абриса с объекта. После завершения процедуры видим такой объект:
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При желании можно немного подкорректировать блик от объекта.
Следующим шагом будет рисование листьев на объекте. Рекомендуем использовать инструмент Кривая Безье.
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Далее следует отредактировать элемент с помощью инструмента создания форм и применить градиентную заливку. В результате получаем симпатичную помидорку. С ней и мы и будем работать дальше.
Следующим шагом нужно разъединить объекты с перетеканием. 
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ВНИМАНИЕ! Не забываем, что у нас было 2 перетекания и разъединить нужно каждый!
Далее создадим гроздь помидорок и отредактируем листья.
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Следующим шагом будет рисование ветки.
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После окончания редактирования ветки и группировки объектов, создадим свечение объекта с помощью интерактивного инструмента Контур.
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Рекомендуем настроить свойства контура для последующего редактирования.
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Выставить параметр Шаги контура равным 3 и Смещение контура равное 1 мм.
Нажимаем на объект и тянем мышь за границы объекта.
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Далее можно редактировать параметры для получения желаемого результата.
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ВНИМАНИЕ! Следует обратить внимание на эти параметры.
[image: ]
Первая группа отвечает за направление контура, в списке: Контур к центру, Внутренний контур и Контур абриса.
Как видим, на приведенном примере стоит третий параметр.
Вторая группа отвечает за цветовую палитру контура и, если объект угловатый, позволяет скосить углы и сделать контур скругленным.
Параметр Цвет контура позволяет задать начальный цвет и по модели HSL.
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Цвет можно смещать по часовой стрелке и против часовой стрелки.
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Для наглядности покажем, что представляют из себя два других параметра.
К центру создает слабое внутреннее свечение объекта.
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Внутренний контур во много раз его усиливает.
[image: ]
Тут же можно подкорректировать количество шагов внутреннего свечения.
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Отдельно стоит поговорить про Ускорение объекта и цвета.
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Для дальнейшей работы стоит разъединить контурную группу, выделить все и сгруппировать в один объект.
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Теперь следует создать текстовую вариацию логотипа.
Для этого создадим текст и подберем шрифт и цвет для него.
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Не забываем перевести текст в кривые. Выберем интерактивный инструмент Блок с тенью.
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Зададим направление тени, а потом выберем ее цвет. Отключим параметры для корректного отображения текста.
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Расположим текст и логотип.
Не забываем после работы с интерактивным инструментом сделать разъединение с объектом.
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Выберем инструмент Оболочка.
[image: ]
В поле Заготовка выберем Нажатие.
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При желании можно подкорректировать точки.
В этом логотипе не использовались только два интерактивных инструмента –Искажение и Вытянуть.
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Шаг 1. Рисуем Месяц
Начните с создания нового документа (Ctrl + N). Для работы с узорами я предпочитаю создавать документ, размером 8 х 8 дюймов, вы можете установить любой размер. Так как узор предназначен для размещения в Интернете, я выбрал Режим основного цвета (Primary color mode) RGB с разрешением отображения (Rendering resolution) 300 dpi на случай, если понадобится распечатать или изменить размер изображения.
[image: Рисуем Месяц]
Шаг 2. Рисуем Месяц
Возьмите Инструмент Эллипс - Ellipse Tool (F7) и нарисуйте круг. Удерживайте клавишу Ctrl во время рисования, чтобы создать круг, а не овал. Затем нарисуйте меньший круг и разместите его так. как показано на рисунке ниже: 
[image: Рисуем Месяц]
Шаг 3. Рисуем Месяц
Выделите обе фигуры (кликните по ним, удерживая Shift). Далее на панели свойств (Property Bar) в секции Менеджер объектов (Objects Manager) нажмите иконку Задние минус передние (Minus Front), чтобы вырезать меньший круг из большего. В итоге получится отличный полумесяц.
[image: Рисуем Месяц]
Шаг 4. Рисуем летучую мышь
1. Рисовать летучую мышь начнем так же, как и месяц: нарисуйте круг с помощью Инструмента Эллипс - Ellipse Tool (F7).
2. Далее возьмите Инструмент Многоугольник - the Polygon Tool (Y), поставьте значение 3 в поле Точки или стороны (Points or Sides) на верхней панели свойств. Затем нарисуйте треугольник.
3. Не переживайте, если у вас не получается подходящий треугольник с первого раза. Используйте Инструмент выбора (Pick Tool), чтобы вращать и масштабировать треугольник.
4. Разместите треугольник сверху круга, поверните его слегка влево (для этого дважды кликните по объекту левой кнопкой мыши при активном Инструменте выбора (Pick Tool), переключаясь таким образом между масштабированием и поворотом).
[image: Рисуем летучую мышь]
Шаг 5. Рисуем летучую мышь
 	Скопируйте и вставьте (Ctrl + C > Ctrl + V) треугольник и на панели свойств нажмите иконку Отразить по горизонтали (Mirror Horizontally). Поместите копию треугольника в правой части круга. Выделите оба треугольника и выровняйте их относительно друг друга по верху, нажав клавишу T.
Или используйте панель Выровнять и распределить (Align & Distribute) - Выровнять по верху (Align Top). Обратите внимание, что в разделе Выравнивание объектов (Align objects to) должна быть нажата иконка Активные объекты (Active objects).
[image: Рисуем летучую мышь]
Шаг 6. Рисуем летучую мышь
Крылья летучей мыши состоят из трех треугольников. Вы можете нарисовать их, используя Инструмент Многоугольник - Polygon Tool (Y) или более гибкий Инструмент Перо (Pen Tool) – выбрать его можно кликнув и подержав на иконке Инструмента Свободная форма (Freehand Tool – F5)
1. Каждый треугольник должен содержать три вершины.
2. Убедитесь, что вы «закрыли» фигуру Инструментом Перо (Pen Tool), вернувшись в начальную точку рисования.
3. Нарисуйте второй треугольник так, чтобы он немного перекрывал первый.
4. Верхние точки треугольников должны находиться на одном уровне.
5. Откорректируйте положение треугольников, используя Инструмент выбора (Pick Tool), чтобы они перекрывали друг друга, а верхние и нижние точки находились на одном уровне. 
[image: Рисуем летучую мышь]
Шаг 7. Рисуем летучую мышь
Выделите все три треугольника и нажмите иконку Объединение (Weld) на панели свойств (Property Bar). Треугольники теперь образуют единую фигуру.
[image: Рисуем летучую мышь]
Шаг 8. Рисуем летучую мышь
Приблизьте верхний угол только что созданной фигуры (либо колесиком мыши, либо с помощью инструмента Масштаб - Zoomed (Z). Возьмите Инструмент Форма - Shape Tool (F10), затем дважды кликните левой кнопкой мыши по лишним точкам. В итоге у вас должна получиться форма из пяти точек.
[image: Рисуем летучую мышь]
Шаг 9. Рисуем летучую мышь
Теперь нужно сделать из этого объекта крыло летучей мыши:
1. Возьмите Инструмент Эллипс через три точки (3-Point Ellipse Tool), проведите линию по двум точкам левой части крыла.
2. Протяните эллипс в сторону, чтобы образовать желаемую выемку крыла летучей мыши.
3. Повторите те же действия для двух других частей крыла.
4. Выделите основную форму крыла и первый эллипс. Нажмите иконку Задние минус передние (Minus Front) на панели свойств (Property Bar).
5. Вот вы вырезали эллиптическую часть из крыла! Итак, продолжим.
6. Повторите действие пункта 4 для двух других частей крыла. Удалите лишние точки, если понадобится.


Шаг 10. Рисуем летучую мышь
Поместите крыло рядом с головой летучей мыши, чтобы оно немного перекрывало голову. Удерживая Ctrl, перетащите крыло в сторону и кликните правой кнопкой мыши – таким образом вы скопируете крыло. Затем кликните на иконку Отразить по горизонтали (Mirror Horizontally) и выровняйте оба крыла друг относительно друга по верху (T) или по центру (Е). Выделите все пять объектов, образующих летучую мышь и нажмите иконку Объединение (Weld) на панели свойств (Property Bar).
Примечание пер.: чтобы выровнять оба крыла и оба уха летучей мыши по центу относительно головы, сгруппируйте оба уха (Ctrl + G) – > выделите группу вместе с головой и нажмите клавишу C; сгруппируйте оба крыла и так же выровняйте их относительно головы, нажав С.
[image: Рисуем летучую мышь]
Шаг 11. Рисуем глаза кота
	Возьмите Инструмент Прямоугольник - Rectangle Tool (F6) и нарисуйте широкий прямоугольник. Затем на панели свойств (Property Bar) кликните на иконку Угол с фаской (Chamfered Corner) и введите значение 2 дюйма в поле Радиус угла (Corner Radius). Таким образом у вас получится шестиугольник.
Вы также можете выбрать Инструмент Многоугольник - Polygon Tool (Y), установить число Точки или стороны (Points or Sides) 6 и нарисовать шестиугольник.
[image: Рисуем глаза кота]
Шаг 12. Рисуем глаза кота
1. Нарисуйте круг внутри шестиугольника, размером приблизительно, как на рисунке ниже.
2. Используйте Инструмент Перо (Pen Tool), чтобы нарисовать дугу от левой точки шестиугольника к правой с касанием нижней части круга.
3. Завершите форму прямой линией от правой точки к начальной точке фигуры слева.
[image: Рисуем глаза кота]
Шаг 13. Рисуем глаза кота
Выберите цвета для каждой формы на свое усмотрение.
1. Скопируйте форму, нарисованную вами в предыдущем шаге.
2. Удалите шестиугольник. На панели свойств (Property Bar) нажмите иконку Отразить по вертикали (Mirror Vertically)
3. Выделите обе половины глаза и нажмите иконку Объединение (Weld) на панели свойств (Property Bar). Затем выделите глаз вместе с кругом и выровняйте их относительно друг друга по центру горизонтально (С), по центру вертикально (E).
[image: Рисуем глаза кота]
Шаг 14. Рисуем глаза кота
1. На время верните объектам белую заливку (fill) с черной обводкой (outline).
2. Скопируйте миндалевидную форму. Затем используя Инструмент выбора (Pick Tool), уменьшите копию так, чтобы она уместилась внутри круга.
3. Поверните эту фигуру на 90 градусов, чтобы она стала вертикально относительно круга.
Вот мы и создали кошачий глаз.
[image: Рисуем глаза кота]
Шаг 15. Завершаем дизайн
Чтобы завершить создание кошачьих глаз, сгруппируйте три объекта (Ctrl + G) и поверните их, как показано ниже. Скопируйте группу и нажмите иконку Отразить по горизонтали (Mirror Horizontally) на панели свойств (Property Bar) – это будет второй глаз. Итак, три элемента дизайна узора готовы, теперь нужно сделать их цветными.
[image: Завершаем дизайн]
Шаг 16. Завершаем дизайн
Разгруппируйте все сгруппированные объекты (Ctrl + U). Скопируйте обе миндалевидные фигуры, образующие кошачьи глаза и примените к копиям обводку (Outline) толщиной (Weight) в 3-4 пункта черного цвета, но без заливки.
Цвета заливки остальных объектов:
Миндалевидные глаза: белый (#FFFFFF);
Радужка глаз: оранжевый (#FF9933);
Зрачки: черный (#000000);
Летучая мышь: фиолетовый (#9933CC);
Месяц: оранжевый (#FF9933).
Выделите все объекты и сгруппируйте их (Ctrl + G)
[image: Завершаем дизайн]
Шаг 17. Завершаем дизайн
Нарисуйте большой прямоугольник и поместите его на задний план (Ctrl + End). Возьмите Инструмент Звезда (Star Tool) и нарисуйте множество пятиконечных звезд разных размеров, чтобы заполнить пространство между элементами дизайна (чтобы ускорить процесс, выделяйте несколько звезд, переносите их  на другое месть и кликайте правой кнопкой мыши, чтобы сделать копию). Также сделайте несколько копий летучей мыши и месяца.
[image: Завершаем дизайн]
Шаг 18. Создание узора
1. Выделите все элементы дизайна, кроме черного прямоугольника. Перейдите в меню Инструменты > Создать > Заливка узором (Tools > Create > Pattern Fill)
2. Выберите пункт Вектор (Vector) в открывшемся окне и нажмите ОК. Затем определите границы узора появившимся инструментом. Это похоже на то, как вы обрезаете изображение или рисуете прямоугольник.
3. Сохраните ваш новый узор, выбрав ему название и примечания, а также решите, будет ли он доступен другим пользователям или нет.
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Шаг 1
Начнем с создания овала при помощи инструмента Ellipse/Эллипс (L). Создайте фигуру размером 241 x 214 px коричневого цвета. Инструментом Direct Selection/Прямое выделение (A) кликните по нижней точке и нажмите Delete чтобы удалить эту точку.
[image: 1-autumn-mushroom.jpg]


Шаг 2
Рисуем еще один овал, на этот раз размером 62 x 192 px и бежевого цвета. Выделите обе фигуры и в палитре Align/Выравнивание кликните по иконке Horizontal Align Center/Горизонтальное выравнивание по центру.
[image: 2-autumn-mushroom.jpg]
Шаг 3
Давайте немного изменим форму ножки гриба. Выделите ее и в меню выберите Effect > Warp > Fish/Эффект>Искажение>Рыба. Настройте параметры как показано ниже и нажмите OK.
[image: 3-autumn-mushroom.jpg]

Шаг 4
Выберите в меню Object > Expand Appearance/Объект>Разобрать оформление. Теперь кликните правой кнопкой мыши по фигуре и выберите Arrange > Send to Back/Упорядочить>На задний план.
[image: 4-autumn-mushroom.jpg]
Шаг 5
Добавим немного деталей шляпке нашего гриба. Инструментом Ellipse/Эллипс (L) рисуем кружочки разных размеров и оттенков — чуть более светлых чем цвет гриба.
[image: 5-autumn-mushroom.jpg]
Шаг 6
Теперь давайте создадим кисть для того, чтобы потом рисовать листья. Начнем с темно-серого овала размером 5 x 25 px. Выделите нижнюю точку овала инструментом Direct Selection/Прямое выделение (A) и в верхней панели выберите Convert Selected anchor points to corner/Преобразовать точку в угол. Сделайте то же с верхней точкой.
[image: 6-autumn-mushroom.jpg]
Шаг 7
Откройте палитру Brushes/Кисти (в меню Window/Окно) и перетащите нашу фигуру в палитру. В появившемся окне выберите Art Brush/Объектная кисть.
[image: 7-autumn-mushroom.jpg]
Шаг 8
Появится окно настроек кисти. Выберите параметры, указанные ниже. Вы сможете изменить их в любой момент, просто кликнув дважды по кисти в одноименной палитре.
[image: 8-autumn-mushroom.jpg]
Шаг 9
Давайте создадим листву в новом слое. Для этого создайте его в палитре Layers/Слои. Теперь возьмите инструмент Paintbrush/Кисть (B) и нарисуйте стебель.
[image: 9-autumn-mushroom.jpg]
Шаг 10
Используйте ту же кисть, чтобы нарисовать листики. Чтобы листья были потолще, увеличьте толщину Stroke/Обводки. Также выберите оранжевый цвет обводки, чтобы сделать листья цветными.

[image: 10-autumn-mushroom.jpg]
Шаг 11
Добавьте много листьев и немного стебельков в нижней части гриба. В палитре Layers/Слои перетащите слой с листьями в самый низ.
[image: 11-autumn-mushroom.jpg]
Шаг 12
При помощи инструмента Ellipse/Эллипс (L) рисуем красные ягодки размером 50 x 50 px. Внутри круга нарисуйте еще один — чуть меньше и светлее.
Поместите ягодки в свою работу!
[image: 12-autumn-mushroom.jpg]











РЕЗУЛЬТАТ
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1. Рисуем голову кошечки
Шаг 1
Инструментом Скругленный прямоугольник/Прямоугольник со скругленными углами нарисуйте фигуру темно-серого цвета размером 125×80 пикселей. Вы можете настроить радиус скругления с помощью функции Live Corners/Живые углы. Давайте возьмем радиус в 30 пикселей, чтобы скругление было больше.
[image: 1-черный-кот-персонаж.jpg]
Шаг 2
Теперь занимаемся левым ухом. Инструментом Pen/Перо (P), зажав Shift, нарисуйте вертикальную линию, прикрепив ее к кошачьей голове. Следующую линию нарисуйте под углом в 45 градусов по направлению к вертикальной линии, образуя треугольник.
[image: 2-черный-кот-персонаж.jpg]
Шаг 3
Соедините две линии цепочек и возьмите пипетку/пипетку (I), скопируйте треугольник темно-серого цветного заливки с головы кошечки.
[image: 3-черный-кот-персонаж.jpg]
Шаг 4
Дублируйте треугольник ушку (Control-C > Control-F) и укажите копию розового цвета. Инструментом Direct Selection/Прямое выделение (A) покажите правую точку треугольника уровня и ниже (как показано на картинке ниже).
Сгруппируйте (Control-G) все элементы и используйте Отразить/Отразить (O) с помощью кнопки Копировать/Копия отразите группу по вертикали.
Поместите обрывающийся брекеты на противоположную часть головы кошечки. Выделите правое ухо и голову, затем щелкните еще раз по голове, чтобы сделать эту фигуру ключевой. В палитре Align/Выравнивание щелкните по значку Horizontal Align Right/Горизонтальное соревнование по левому краю.
[image: 4-черный-кот-персонаж.jpg]
Шаг 5
Выделите оба уха, щелкните по ним правым нажатием и выберите «Расположить» > «Назад/Расстановка»> «На заднем плане», чтобы поместить уши за голову.
[image: 5-черный-кот-персонаж.jpg]
Шаг 6
Инструментом Эллипс/Эллипс (L) нарисуйте круг размером 33×33 пикселей желтого цвета. Внутри этого круга нарисуйте темный круг поменьше. Это будет глаз. Дублируйте оба круга и поместите глаза на свои места.
[image: 6-черный-кот-персонаж.jpg]
Шаг 7
Инструментом Полигон/Многоугольник создайте фигуру с углом поворота и радиусом в 10 пикселей. Инструментом Прямой выбор/Прямое выделение (A) с помощью функции Live Corners/Живые углы скруглите углы треугольника.
Разместите одежду на лице-кошечке и используйте Pen/Pero (P), нарисовав две линии, которые будут обратными.
[image: 7-черный-кот-персонаж.jpg]

2. Рисуем тело кошечки
Шаг 1
Возьмите инструмент Прямоугольник/Прямоугольник (М) и нарисуйте фигуру размером 15×85 пикселей. Это будет лапка. Инструментом «Прямое выделение/Прямое выделение» (A) выделите нижние точки лапки и скруглите углы. Нажмите Alt-Shift и потяните лапу вправо, чтобы найти внешний вид.
[image: 8-черный-кот-персонаж-539x1024.jpg]
Шаг 2
Нарисуйте еще один контур, как показано ниже. Выделите лапки и контур и щелкните по значку Unite/Объединить в палитре Pathfinder/Обработка контура. После этого используйте «Прямое выделение/Прямое выделение» (A) скруглите края между лапками.
[image: 9-черный-кот-персонаж-464x1024.jpg]
Шаг 3
Нарисуйте контур более темного цвета, как показано на рисунке ниже, и переместите его на задний план (Control-Shift-[). Инструментом Эллипс/Эллипс (L) нарисуйте круг размером 125×125 пикселей и закрепите его справа от кошечки, как показано ниже.
[image: 10-черный-кот-персонаж.jpg]
Шаг 4
Давайте нарисуем заднюю лапку. Нарисуйте овал, как показано ниже, и возьмите ножницы/ножницы © кликните по обеим боковым точкам, чтобы разрезать фигуру пополам. Удалите нижнюю фигуру, оставив только верхнюю половину овала. Укажите ей чуть более светлый оттенок серого и немного под левой передней лапкой. Затем дорисуйте треугольник тоже светлого серого за спиной у кошечки, как показано ниже.
[image: 11-черный-кот-персонаж.jpg]
Шаг 5
Инструментом Arc/Дуга нарисуйте хвост. В палитре Обводка/Обводка указывается жирная обводка размером 10 пт и скругленные капители.
[image: 12-черный-кот-персонаж.jpg]
Шаг 6
Теперь мы можем добавить мелкие детали, чтобы сделать работу интереснее.
Инструментом Pen/Pero (P) нарисуйте короткую линию светло-серого цвета, и укажите их в палитре Stroke/Обводка толстой обводки в 1 pt и профиль Width Profile 1.
Удерживая Alt-Shift с помощью инструмента «Выделение/Выделение» (V), отложите линию справа. Дважды нажмите Control-D, чтобы создать еще две копии линии.
[image: 13-черный-кот-персонаж.jpg]
Шаг 7
Сгруппируйте (Control-G) линии и символы еще по одному ряду из трех линий, затем из двух, образуя пирамиду, как на картинке ниже. Добавьте такие же линии на телу кошечки и на лапках.
[image: 14-черный-кот-персонаж.jpg]




Результат
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Начнем рисовать чашку с круга. С помощью инструмента Ellipse Tool (L) / Эллипс создайте круг с размерами 275×275 пикселей.
Возьмите инструмент «Ластик» (Shift-E) / Ластик, удерживая кнопку Alt, сотрите верхнюю половинку круга. Проделайте то же самое с нижней частью, но удалите контур не полностью, как на картинке внизу, чтобы получилась столешница.
Вытяните фигуру, чтобы чашка стала чуть выше.
[image: 01.jpg]
Шаг 2
Возьмите инструмент Rounded Rectangle Tool / Прямоугольник со скругленными углами и нарисуйте фигуру с размерами 175×20 пикселей. Это будет блюдце. Используйте ластик, чтобы поднять верхнюю часть блюдца, и прикрепите становящуюся фигуру к чашке маленького размера.
Задайте блюдцу чуть более темный цвет, чем чашка.
[image: 02.jpg]
Шаг 3
Теперь мы добавим ушко. Нарисуйте с помощью инструмента Rectangle Tool (M) / Прямогольник фигуру размерами 130×80 пикс. Выделите чашку и этот поворот, а затем снова чашку, чтобы сделать ее ключевой фигурой. Зайдите в палитру Выравнивание/Выравнивание и щелкните по Вертикальное выравнивание сверху/Вертикальное выравнивание Вверх, чтобы выровнять обе фигуры по верху чашки.
Теперь можно применить инструмент Direct Selection Tool (A) / Прямое выделение и функцию Live Corners / Живые углы, чтобы скруглить кухонную чашку, вытянув маркеры.
[image: 03.jpg]
Шаг 4
Выделите ушко чашки и замените Объект > Путь > Смещение пути/Объект > Контур > Создать параллельный контур, установив Смещение/Смещение на -20 размера, чтобы создать уменьшенную фигуру.
Выделите обе фигуры и замените функцию Минус Фронт / Минус Верхний из палитры Pathfinder / Обработка Контуров. Так мы удалим внутреннюю фигуру.
Наконец, поместите ушко чашки за саму чашку с помощью случайных клавиш Shift-Control-[.
[image: 04.jpg]
Шаг 5
Давайте теперь добавим нашу плоскую чашку, полупрозрачную тень. Выделите все элементы чашки и с помощью Control-C > Control-F сделайте дубликат. Держите копии выделенными и замените Unite / Объединение из палитр Pathfinder / Обработка Контуров. Теперь они стали одной фигурой.
Удерживая кнопку Alt, используйте инструмент «Ластик» (Shift-E) / Ластик, чтобы закрыть крышку половины объединенной фигуры. Переключите Режим наложения / Режим Наложения оставшейся части чашки на Умножение / Умножение. Скорректируйте цвет, а затем установите правую часть чашки.
[image: 05.jpg]
Шаг 6
Теперь давайте сделаем стилизованный пар, поднимающийся от чашки вверх. Используем инструмент Line Segment Tool (\) / Отрезок Линии и, удерживая кнопку Shift, нарисуем три вертикальные линии. Зададим обводку толщиной 6 pt, а в полях Cap и Corner установим положение по центру, как на карте внизу.
Теперь делаем Эффект > Исказить и трансформировать > Зигзаг/Эффект > Искажение и преобразование > Зигзаг. Задайте параметры, как на скриншоте.
[image: 06.jpg]
Шаг 7
Теперь нам нужен простой зеленый чайный листик. Воспользуемся инструментом Ellipse Tool (L) / Эллипс и нарисуем круг размерами 90×90. Выделите его верхнюю точку с помощью инструмента «Прямое выделение» (A) / Прямое выделение и замените Преобразовать выбранную опорную точку в угол / Преобразовать Опорную Точку в Угол.
Потяните немного вверх эту точку, сделайте фигуру длиннее и используйте инструмент «Отрезок линии» (\)/Отрезок линии, чтобы нарисовать вертикальный отрезок по центру листа.
[image: 07.jpg]
Шаг 8
Таким же методом добавьте немного прожилок. Выделите их, обратитесь к консультанту, нажмите на инструмент «Зеркальное отражение» (O) / Зеркальное отражение и выберите там «Вертикальная ось» / «Вертикальная ось».
Нажмите Копировать / Копировать, чтобы развернуть объект горизонтально и сделать прожилки на противоположной стороне.
[image: 08.jpg]
Шаг 9
Нарисуйте еще один листик, но темнее и проще, чем предыдущий, и поместите оба элемента позади чашки так, чтобы они начертили композицию.
[image: 09.jpg]
Шаг 10
Давайте завершим наш дизайн логотипа, добавив текст.
С помощью инструмента Artboard Tool (Shift-O) / Область Кадрирования сделайте холст квадратным, задав размеры 600×600. Поместите чашку в центр монтажной области и запишите нужную фразу с помощью инструмента Type Tool (T) / Текст.
[image: 10.jpg]










Результат
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